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RAMOS, B. P., RIBEIRO, J. A. G. Identificação do fenômeno aeroelástico de flutter a 

partir de simulações FSI (fluid-structure interaction). 2018. 78 p. Projeto de Conclusão de 

Curso, Universidade Federal de Uberlândia, Uberlândia, Brasil. 

 

RESUMO 

As análises aeroelásticas são parte essencial do projeto aeronáutico. É necessário saber se 

fenômenos aeroelásticos como o flutter estão dentro do envelope de voo, para que catástrofes 

sejam evitadas. Para isso, muito comum usar o NASTRAN, que utiliza o Método Doublet 

Lattice como solução aerodinâmica. No entanto, esse método pode não ser o mais adequado 

aerodinamicamente e a utilização de CFD pode trazer melhores resultados. Nesse contexto, este 

trabalho propõe a identificação do flutter através de um método FSI (interação fluido-estrutura). 

Utilizando o software ANSYS, é possível acoplar os módulos estrutural e fluidodinâmico, de 

maneira a fazer com que o estrutural envie deslocamentos para o fluidodinâmico e o 

fluidodinâmico envie forças para o estrutural. A partir do sinal de deslocamento temporal em 

um ponto selecionado, pode-se avaliar o comportamento aeroelástico. Essa metodologia foi 

aplicada para a geometria da asa AGARD 445.6. Foi possível encontrar o flutter, como 

esperado, ao se realizar várias simulações com o escoamento a diferentes velocidades. 

 

Palavras chave: aeroelasticidade, flutter, interação fluido-estrutura, AGARD 445.6. 

  



viii 

 

RAMOS, B. P., RIBEIRO, J. A. G. Flutter identification using FSI (Fluid Structure 

Interaction). 2018. 78 p. Graduation Project, Federal University of Uberlândia, Uberlândia, 

Brazil. 

 

ABSTRACT 

Aeroelastic analyses are an essential part of aeronautical projects. To avoid catastrophes, it is 

necessary to know if aeroelastic phenomena like flutter are present in the flight envelope. For 

that, it is common to use NASTRAN. It applies Double Lattice Method as aerodynamic solver. 

However, this method might not be the most appropriate one aerodynamically and CFD can 

achieve better results. In this context, this work suggests to identify flutter through FSI method 

(fluid-structure interaction). Using ANSYS software, it is possible to couple structural and 

fluid-dynamic modules in order to make the structural send displacements to fluid-dynamic, 

and the fluid-dynamic send forces to structural. From the displacement temporal sign, on a 

selected point, the aeroelastic behavior can be evaluated. This methodology was applied on 

AGARD 445.6 wing. It was possible to find flutter, as expected, by simulating flow on different 

velocities.  

 

Keywords: aeroelasticity, flutter, fluid-structure, AGARD 445.6. 
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CAPÍTULO I 

 

INTRODUÇÃO 

 

 

“I now myself live, in every detail, 

striving for wisdom while I formerly merely 

worshipped and idolized the wise.” – Friedrich 

Nietzsche 

 

 Uma das principais preocupações dos setores aeronáutico e aeroespacial, em um projeto 

de engenharia, é a busca por materiais que sejam capazes de fornecer propriedades que tornem 

uma estrutura capaz de suportar todas as cargas previstas ao longo de sua vida útil, e que, ao 

mesmo tempo, confira-a baixo peso.  

 Nesse sentido, uma das tendências registradas ao longo dos anos, nos projetos 

aeronáuticos, é a adoção de materiais compósitos em diversos componentes da aeronave. 

Segundo Guimarães (2016), os materiais compósitos apresentam comprovados benefícios 

estruturais, como elevada razão resistência/peso, comportamento favorável à fadiga, bem como 

versatilidade para diversas aplicações.  
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 Como exemplo disso, pode-se citar a aeronave Boeing 787, que é um dos mais modernos 

e tecnologicamente avançados modelos produzidos pela companhia. Materiais como as ligas de 

alumínio e titânio são empregados em menor escala que os compósitos. Estes, por sua vez, são 

responsáveis por 50% do peso total dos materiais utilizados na aeronave. (Figura 1.1) 

 

 

Figura 1.1. Uso de materiais no Boeing 787. 

 

 Também é possível notar, através da Figura 1.1, que a asa é constituída, em sua maior 

parte, por materiais compósitos. 

 Outra tendência registrada no mercado aeronáutico é o aumento do alongamento alar. 

Enquanto isso pode favorecer favorável aerodinamicamente, por conta da redução do arrasto 

induzido, fatores estruturais e aeroelásticos devem ser levados em consideração.  

 Combinadas, essas duas tendências fazem com que as asas se tornem cada vez mais 

leves e flexíveis. Esse fator é o ponto de partida para que fenômenos aeroelásticos passem a se 

evidenciar. Para garantir que uma aeronave possa cumprir sua missão, é necessário prever que 

esses fenômenos, como a divergência ou o flutter, estejam fora do envelope de voo.  
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1.1 Aeroelasticidade 

 

A teoria da Aeroelasticidade é descrita por Fung (1955), Bisplinghoff, Ashley e 

Halfman (1955), Dowell (1980), entre outros. Uma perspectiva histórica de pesquisas 

realizadas nessa área é dada por Collar (1978). A natureza multidisciplinar da aeroelasticidade 

é ilustrada pelo Diagrama dos Três Anéis sugerido por Yates (The Three Ring Diagram, 1971) 

e suas variações. 

O diagrama de Yates destaca-se pela sua simplicidade em mostrar que a aeroelasticidade 

envolve interações entre forças aerodinâmicas, inerciais e elásticas. Trata-se de um problema 

acoplado no qual as cargas aerodinâmicas provocam deformações na estrutura e essa 

deformação, por sua vez, afeta a força aerodinâmica resultante. A interação do sistema dinâmico 

(inércia e rigidez) e o escoamento do fluido (carregamento aerodinâmico) em um corpo flexível 

é denominada sistema aeroelástico. As forças de inércia são resultantes das acelerações da 

massa, as forças elásticas são resultantes das deformações e as forças aerodinâmicas são 

resultantes do escoamento do fluido. 

O campo de estudo relativo à aeroelasticidade estática envolve interações entre as forças 

aerodinâmicas e elásticas, ou seja, nas condições de voo de cruzeiro ou manobras estabilizadas, 

desconsiderando os efeitos oscilatórios da carga aerodinâmica. De maneira simplificada, a 

aeroelasticidade estática avalia o efeito da natureza flexível da asa, que faz com que sua forma 

seja alterada em voo e, consequentemente, sua distribuição de sustentação é modificada e pode 

levar a redução da efetividade das superfícies de controle (C), reversão de comando (R), 

redistribuição de carga (L) e divergência (D), na qual a estrutura perde sua capacidade de 

restauração elástica. 

O campo da aeroelasticidade dinâmico considera a interação das forças aerodinâmicas, 

inerciais e elásticas. A resposta dinâmica (Z) trata das respostas transientes dos componentes 

estruturais da aeronave devido a rajadas, pouso, ondas de choque ou outras cargas dinâmicas 

abruptas. O buffeting (B) envolve a análise de vibrações transientes nos componentes 

estruturais, oriundas de impulsos produzidos por esteiras de vórtice provenientes da asa, motor, 

entre outros.  
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O flutter (F) é outro fenômeno dentro da aeroelasticidade dinâmica e será detalhado na 

próxima seção. Dentro do campo de aeroelasticidade dinâmica tem-se a aeroservoelasticidade, 

a qual analisa a interação do sistema de controle de voo com os modos flexíveis. 

 

 

Figura 1.2. Triangulo de Collar. 

 

Além dessa classificação, os fenômenos aeroelástico podem ser classificados em 

problemas de estabilidade e de resposta. Os problemas de estabilidade, modelados através de 

equações homogêneas, avaliam a velocidade crítica do vento, de acordo com as características 

de inércia e rigidez da estrutura, na qual o sistema aeroelástico se tornará instável, levando o 

corpo a apresentar deformações excessivas e, possivelmente, uma falha catastrófica. A 

instabilidade ocorre nos casos em que a estrutura absorve energia do escoamento e, 

consequentemente, aumenta a amplitude de vibração ao longo do tempo. Os problemas de 

resposta avaliam deslocamento, movimento ou tensão do sistema aeroelástico devido a uma 

carga externa aplicada. Em vista das classificações apresentadas, Collar categorizou os 

fenômenos aeroelásticos através de um triângulo de forças (Collar triangle). 

Qualquer corpo imerso em um escoamento estará sujeito a pressões induzidas pelo 

fluido, na superfície sólida do corpo. Se o escoamento incidente for turbulento, o mesmo será 
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fonte de excitações transientes na superfície do corpo imerso. Se o corpo se move ou se deforma 

consideravelmente sob as forças aerodinâmicas inferidas pelo escoamento, essas deformações 

alteram as condições de contorno do escoamento, alterando as forças aerodinâmicas sobre o 

corpo. Aeroelasticidade é a área multidisciplinar que realiza o estudo do fenômeno onde forças 

aerodinâmicas e estruturais interagem de maneira significante (Simiu and Scanlan, 1996). 

Define-se instabilidade aeroelástica caso o corpo apresente deflexões sob esforços e esta 

deflexão inicial dê início a sucessivas deflexões de natureza oscilatória divergente.  

Todas instabilidades aeroelásticas envolvem forças aerodinâmicas que agem sobre o 

corpo e são consequências da deflexão do mesmo. Tais forças são denominadas auto excitadas. 

 

1.2 Interação fluido-estrutura 

 

Problemas que envolvem a interação fluido-estrutura, do inglês fluid-structure 

interaction (FSI), são extremamente comuns em várias áreas da engenharia. Por exemplo, tem-

se a ação do vento sobre estruturas, escoamentos em canais e vertedores, a água interagindo 

com barragens, rotores de máquinas rotativas, turbinas eólicas, entre outros. Esse tipo de 

interação se aplica até mesmo à bioengenharia, com a simulação de escoamentos 

cardiovasculares. (Fernandes, 2016). 

A interação fluido estrutura nada mais é que o acoplamento entre as leis físicas da 

dinâmica dos fluidos e da mecânica estrutural, considerando as forças aerodinâmicas, elásticas 

e inerciais. Ela analisa como o escoamento influencia em aspectos da estrutura com a qual ele 

interage e/ou vice-versa. Portanto, trata-se de um problema multidisciplinar. 

As análises de interação fluido-estrutura podem ser de uma ou de duas vias. 

O FSI 1 way (interação fluido-estrutura de uma via) exige menos recurso computacional. 

Seu funcionamento se dá, inicialmente com a atuação do solver responsável pela modelagem 

da parte do problema que envolve o fluido (Computational Fluid Dynamics - CFD). Os 

resultados são transferidos para o solver que realiza a análise estrutural (Finite Element 

Analysis – FEA), de modo que ele passa a considerar os carregamentos causados pelo fluido 

que passam a agir na estrutura.  
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Figura 1.3. Interação fluido-estrutura de uma via. 

 

Já no FSI 2 way (interação fluido-estrutura de duas vias), a análise CFD é resolvida e os 

resultados são encaminhados para a análise estrutural FEA. O carregamento, produzido pelo 

fluido, aplicado na estrutura, gera um deslocamento. Esse deslocamento é significativo para 

alterar o domínio fluido, e, portanto, é encaminhado para o CFD, de modo que ela passa a 

considera-lo ao fazer uma nova análise. Essa nova análise é transmitida para a FEA, 

completando assim o ciclo de acoplamento. No entanto, o custo computacional desse processo 

é maior, quando comparado ao 1 way FSI.  

 

 

Figura 1.4. Interação fluido-estrutura de duas vias. 

 

1.3 Organização do trabalho 

 

Esse trabalho foi organizado como descrito a seguir: 

• Capítulo II: é realizada uma revisão bibliográfica a respeito dos estudos realizados na 

área de interação fluido-estrutura, principalmente aqueles que analisam aspectos 

aeroelásticos. Também são apresentados os estudos relacionados à asa AGARD 445.6. 
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• Capítulo III: a metodologia utilizada para a realização das análises aeroelásticas é 

apresentada de maneira breve, bem como o equacionamento utilizado pelo software 

estrutural e aerodinâmico, focando também na integração e acoplamento destes. 

• Capítulo IV: são apresentados os dados da AGARD 445.6, bem como todas as análises 

realizadas utilizando sua geometria e suas propriedades físicas, desde a simples análise 

modal e validação dos modos de vibrar, até a identificação do flutter através do 

acoplamento de duas frequências. Além disso, são mostrados os resultados obtidos e 

discussões pertinentes acerca destes. Essa sessão tem como principal objetivo validar 

os métodos utilizados durante o trabalho. 

• Capítulo V: são apresentadas as conclusões e considerações finais do trabalho.  



 

 

 

 

 

 

 

 

 

CAPÍTULO II 

 

FUNDAMENTAÇÃO TEÓRICA 

 

 

“A natureza faz poucas pessoas fortes, 

mas esforço e treinamento fazem muitas.” – 

Nicolau Maquiavel 

 

 Neste capítulo, é realizada a revisão bibliográfica acerca dos principais temas que são 

abordados no trabalho. Inicialmente, são apresentados alguns elementos estudados pela 

aeroelasticidade. Em seguida, é apresentada uma revisão bibliográfica referente às análises da 

asa AGARD 445.6. 

 

2.1 Interação Fluido-Estrutura  

 

Raja (2012) em sua tese conduziu análises de problemas do tipo FSI em um membro 

estrutural do tipo cilindro delgado típico, utilizado como braçadeira de uma estrutura marítima 

treliçada. Os componentes nos quais a estrutura se apoia (próximos à superfície da água) são 

sujeitos a cargas induzidas pelas ondas. Gradualmente, essa interação leva o componente a um 
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estado de fadiga estrutural. O problema foi abordado de modo separado, utilizando métodos de 

acoplamento (one-way e two-way), a fim de simular o comportamento do cilindro sujeito a 

cargas hidrodinâmicas provenientes das ondas. 

Kesti & Olsson (2014) realizou a análise de carenagens localizadas abaixo de veículos 

automotivos (underbody panels) a fim de detectar deformações do componente quando o 

mesmo estiver sob escoamento de fluido, no caso, o ar. O método FSI foi aplicado utilizando 

malhas deformantes e detectou pequenas oscilações nos componentes analisados.  

Larsson & Suphap (2006) utilizou dois métodos de interação fluido estrutura 

(unidirecional e bidirecional) com o objetivo de comparar o acoplamento fluido-estrutural dos 

dois métodos e avaliar se seria possível aplica-los para um bocal de modo integral. A análise 

transiente foi conduzida por 3 segundos e foi capaz de calcular as forças, deslocamentos e 

transferência de calor provenientes do escoamento do fluido. 

Byrd (2012) aplicou técnicas de simulação do tipo FSI para complementar simulações 

de CFD de um micro veículo aéreo com asas do tipo flapping. Foi analisado as frequências e 

amplitudes de oscilação das asas, bem como as forças aerodinâmicas geradas pela 

movimentação das mesmas. Foi comprovado na tese a viabilidade da utilização de métodos de 

FSI para simulação de condições transientes. 

Zhang (2003) realizou a análise transiente do escoamento de ar através de pontes longas 

suspensas por cabos. A análise foi feita utilizando o método FSI do tipo two-way avaliando as 

amplitudes e frequências de oscilação de seções transversais da estrutura nas direções lateral e 

vertical. A análise do flutter no domínio da frequência se deu utilizando o método de Jain et al 

(1996). 

 

2.2 Modelo Aeroelástico de Aerofólios Finos 

 

As forças atuantes em um aerofólio fino sob movimento senoidal h e 𝛼, 

 
ℎ = ℎ0𝑒𝑖𝛼𝑡 

(2.1) 

 

 𝛼 = 𝛼0𝑒𝑖𝜔𝑡, (2.2) 
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são dadas por Theodorsen (1935) a partir dos princípios do escoamento potencial 

bidimensional. As expressões para 𝐿ℎ e 𝑀𝛼 são lineares para ℎ, 𝛼 e suas primeiras derivadas. 

 
𝐿 = −𝜋𝜌𝑏2(𝑈𝛼̇ + ℎ̈ − 𝑏𝑎𝛼̈) − 2𝜋𝜌𝑈𝐶(𝑘)(𝑈𝛼 + ℎ̇ + 𝑏 (

1

2
− 𝑎) 𝛼̇) 

(2.3) 

 

 
𝑀 = −𝜋𝜌𝑏2 {(

1

2
− 𝑎) 𝑈𝑏𝛼̇ + 𝑏2 (

1

8
+ 𝑎2) 𝛼̈ − 𝑎𝑏ℎ̈}

+ 2𝜌𝑈𝑏2𝜋 (
1

2
+ 𝑎) 𝐶(𝑘) [𝑈𝛼 + ℎ̇ + 𝑏 (

1

2
− 𝑎) 𝛼̇], 

 

(2.4) 

 

 

onde 𝑘 = 𝑏𝜔/𝑈 é a frequência reduzida, 𝑏 é a meia-corda do aerofólio, 𝑎𝑏 é a distância entre 

a meia corda e o ponto de rotação, 𝜌 é a densidade do ar, 𝑈 é a velocidade do fluido e 𝜔 é a 

frequência de oscilação. A função complexa 𝐶(𝑘) = 𝐹(𝑘) + 𝑖𝐺(𝑘) é a função de Theodorsen. 

Os coeficientes da expressão, denominados coeficientes aerodinâmicos, são definidos em 

termos de duas funções teóricas 𝐹(𝑘) e 𝐺(𝑘), 

 
𝐹(𝑘) =

𝐽1(𝑘)[𝐽1(𝑘) + 𝑌0(𝑘)] + 𝑌1(𝑘)[𝑌1(𝑘) − 𝐽0(𝑘)]

[𝐽1(𝑘) + 𝑌0(𝑘)]2 + [𝑌1(𝑘) − 𝐽0(𝑘)]2
 

(2.5) 

 

 

 
𝐺(𝑘) =

𝑌1(𝑘)𝑌0(𝑘) + 𝐽1(𝑘)𝐽0(𝑘)

[𝐽1(𝑘) + 𝑌0(𝑘)]2 + [𝑌1(𝑘) − 𝐽0(𝑘)]2
, (2.6) 

nas quais 𝐽0 e 𝐽1 são funções de Bessel do primeiro tipo e, 𝑌0 e 𝑌1 são funções de Bessel do 

segundo tipo. 

Esta equação está no domínio misto do tempo e frequência. A expressão é então 

transformada para o domínio temporal. 

Wagner (1925) mostrou que a evolução da sustentação com o tempo adimensional 𝑠 =

𝑈𝑡/𝑏 agindo em um aerofólio teórico do tipo placa plana, dado uma função degrau que perturbe 

𝛼0 no ângulo de ataque é dado por: 

 
𝐿 =

1

2
𝜌𝑈2(2𝑏)(2𝜋)𝛼0𝜙(𝑠), (2.7) 

   

onde 𝜙(𝑠) é a função de Wagner: 

 
𝜙(𝑠) =

1

2𝜋𝑖
∫

𝐶(𝑘)

𝑘
𝑒𝑖𝑘𝑠𝑑𝑘

∞

−∞ 

 (2.8) 
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e C(k) é a função de Theodorsen e k é a frequência reduzida. 

Para movimentos arbitrários, a força de sustentação é dada por: 

 
𝐿(𝑠) = −

1

2
𝜌𝑈2(2𝑏)(2𝜋) ∫ 𝛼3

4

′
𝑠

−𝑠

(𝜎)𝜙(𝑠 − 𝜎)𝑑𝜎, (2.9) 

   

onde 𝛼3/4
′ =

𝑑

𝑑𝑠
𝛼3/4(𝑠) e 𝛼3/4 é o ângulo de ataque efetivo, dado por 

 
𝛼3/4 = [𝛼 +

ℎ

𝑈
+ 𝑏 (

1

2
− 𝑎)

𝛼̇

𝑈
 ] 

̇
 (2.10) 

 ℎ̇ é a velocidade vertical e 𝑎𝑏 é a distância da meia-corda até o ponto de referência, onde cada 

deflexão e rotação são medidas.  

Jones [1940] introduziu a aproximação racional das cargas transientes em uma seção 

típica de aerofólio em escoamento incompressível com o objetivo de facilitar a análise de 

estabilidade de flutter. No domínio do tempo adimensional, 

 𝜙(𝑠) ≅ 1 − 0,165𝑒−0,0455𝑠 − 0,333𝑒−0,300𝑠 (2.11) 

  Kussner (1936) considerou o problema de um aerofólio com velocidade horizontal 𝑈 , 

à jusante, adentrando uma rajada de vento vertical infinita e de velocidade 𝑤0. Foi determinado 

que a sustentação, nessas circunstâncias, segue a função: 

 
𝐿(𝑠) =

1

2
𝜌𝑈2𝐵(2𝜋)

𝑤0

𝑈
𝜓(𝑠),    (2.12) 

com 𝐿 e 𝑤0 considerados positivos para cima e 𝜓(𝑠) é a função de Kussner definida 

aproximadamente por Jones (1941) 

 𝜓(𝑠) ≅ 1 − 0,500𝑒−0,130𝑠 − 0,500𝑒−𝑠. (2.13) 

Para uma rajada de velocidade vertical 𝑤(𝑠) arbitrária, a sustentação gerada por um 

aerofólio passando através da mesma será dada por: 

 
𝐿(𝑠) = 𝜋𝜌𝑈𝐵 ∫ 𝑤(𝜎)𝜓′(𝑠 − 𝜎)𝑑𝜎

𝑠

−∞

. (2.14) 

   

Para uma rajada que apresenta velocidades senoidais da forma 𝑤(𝑠) = 𝑤0𝑒𝑖𝑘𝑠, Sears 

(1941) derivou a sustentação oscilatória correspondente do aerofólio na forma 
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𝐿(𝑠) =

1

2
𝜌𝑈2𝐵(2𝜋)

𝑤0

𝑈
Θ(k)e𝑖𝑘𝑠, (2.15) 

onde Θ(𝑘) é uma função complexa no domínio da frequência conhecida como função de Sears. 

É claro que as funções de Kussner e Sears são um par da transformação de Fourier: 

 
Θ(𝑘) = 𝑖𝑘 ∫ 𝜓(𝜎)𝑒−𝑖𝑘𝜎𝑑𝜎.

∞

0

 (2.16) 

Foi mostrado posteriormente por Fung (1955) que a função de Sears Θ(𝑘) é relacionada 

com a função de Theodorsen 𝐶(𝑘) a seguir: 

 Θ(𝑘) = 𝐶(𝑘)[𝐽0(𝑘) − 𝐽1(𝑘)] + 𝑖𝐽1(𝑘),  (2.17) 

onde 𝐽0 and 𝐽1 são funções de Bessel de argumento k. 

As formas espectrais de 𝐿(𝑠) também são disponibilizadas, porém não serão revisadas 

neste trabalho. 

 

2.3 Flutter 

 

Flutter é uma oscilação auto excitada (Jain et al. 1996, Matsumono et al. 1994; and Chen 

et al. 2000). O modo de flutter aparece após a mudança de um modo puramente estrutural para 

um modo aeroelástico incorporando os efeitos de acoplamento aeroelástico. O sistema 

estrutural, através das deflexões e suas derivadas, absorve energia do escoamento incidente. 

Caso o sistema seja submetido a uma perturbação inicial, o movimento resultante apresentará 

decaimento ou divergência para a instabilidade, caso a quantidade de energia extraída do ar 

exceda ou não a energia dissipada pelo sistema através do amortecimento estrutural. A linha 

tênue entre o decaimento e o caso de instabilidade, geralmente senoidal, é denominada condição 

crítica de flutter, ou limiar de flutter, onde o amortecimento do sistema passa a apresentar valor 

negativo. 

 

 

 

2.4 AGARD 445.6 
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No presente trabalho, um problema de interação fluido-estrutura será apresentado 

utilizando a asa AGARD 445.6, que é um experimento padrão, conduzido por Yates Jr (1987), 

do fenômeno de flutter. Extensas pesquisas foram realizadas utilizando este modelo. (Lee-

Rausch & Batina 1993, 1996, Lesoinne & Farhat 1998, Liu et al. 2001, Geuzaine et al. 2003, 

Thirifay & Geuzaine 2008, Chen et al. 2007). Mais recentemente, (Goud et al. 2014) realizou 

a simulação do tipo FSI para este modelo e discutiu os resultados de pressão, energia cinética 

turbulenta e temperatura sobre a asa.  

Lee-Rausch & Batina (1993) avaliou as características da resposta dinâmica da AGARD 

445.6 e o fenômeno de flutter aeroelástico utilizando um algoritmo transiente de Navier-Stokes 

afim de investigar discrepâncias entre as características de flutter resultantes do algoritmo de 

Euler e os dados experimentais, na região transônica. O comportamento aeroelástico de flutter 

da asa é determinado utilizando as forças aerodinâmicas transientes resultantes em uma análise 

clássica do tipo V-g.  

Thirifay & Geuzaine (2008) utilizou o modelo AGARD 445.6 para validar o 

desenvolvimento de metodologias computacionais eficientes para a simulação de problemas de 

interação fluido-estrutura. Resultados numéricos indicaram boa concordância com os 

resultados experimentais conduzidos por Yates Jr. na região subsônica e transônica. Resultados 

menos favoráveis foram obtidos na condição supersônica.  

 

 



 

 

 

 

 

 

 

 

 

CAPÍTULO III 

 

METODOLOGIA 

 

 

“Science is organized knowledge. 

Wisdom is organized life.” – Immanuel Kant 

 

 Neste capítulo, procura-se descrever, de maneira sucinta, através de equações, a 

abordagem do software de elementos finitos e de dinâmica dos fluidos, bem como o 

acoplamento e integração entre estes.  

 

3.1 CFD  

 

 O equacionamento apresentado a seguir é utilizado pelo software CFX na resolução dos 

problemas descritos no presente trabalho.  

  Inicialmente, define-se, pelo princípio da conservação de massa, a equação da 

continuidade. Ela pode ser escrita, para um fluido compressível, como: 
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 𝜕𝜌

𝜕𝑡
+ 𝑑𝑖𝑣(𝜌𝑢) = 0, (3.1) 

onde 𝜌 representa a densidade e 𝑢 representa a velocidade do fluido. O primeiro termo da 

equação é a taxa de variação da densidade com respeito ao tempo e o termo seguinte é o fluxo 

de massa fora das fronteiras do elemento. 

 Outro equacionamento utilizado pelo software é a Segunda Lei de Newton e a equação 

do momento. A Segunda Lei estabelece que a taxa de variação do momento de uma partícula 

de fluido é igual a soma das forças atuando nessa partícula. Quando essa lei é aplicada para um 

fluido newtoniano (com tensão viscosa proporcional às taxas de deformação), resulta nas 

equações de Navier Stokes. Essas equações, escritas abaixo, explicam o princípio de 

conservação do momento, 

 𝜕(𝜌𝑢)

𝜕𝑡
+ 𝑑𝑖𝑣(𝜌𝑢u) = −

𝜕𝑝

𝜕𝑥
+ 𝑑𝑖𝑣(𝜇 𝑔𝑟𝑎𝑑 𝑢) + 𝑆𝑀𝑥 (3.2) 

   

 𝜕(𝜌𝑣)

𝜕𝑡
+ 𝑑𝑖𝑣(𝜌𝑣u) = −

𝜕𝑝

𝜕𝑦
+ 𝑑𝑖𝑣(𝜇 𝑔𝑟𝑎𝑑 𝑣) + 𝑆𝑀𝑦 (3.3) 

   

 𝜕(𝜌𝑤)

𝜕𝑡
+ 𝑑𝑖𝑣(𝜌𝑤u) = −

𝜕𝑝

𝜕𝑧
+ 𝑑𝑖𝑣(𝜇 𝑔𝑟𝑎𝑑 𝑤) + 𝑆𝑀𝑧 (3.4) 

   

onde u representa o vetor de velocidade com componentes 𝑢, 𝑣, 𝑤 no sistema de coordenadas 

cartesiano, 𝜇 é a viscosidade dinâmica e 𝑆𝑀 representa o termo fonte de momento. 

 É importante ressaltar que, como a aplicação deste trabalho não envolve transferência 

de calor, a equação da energia não é considerada. 

 

3.2 Método dos volumes finitos 

 

 O método dos volumes finitos é uma das técnicas numéricas aplicadas em códigos CFD 

comerciais para resolver as equações governantes do fluido em questão. O primeiro passo da 

análise é dividir o domínio computacional (geometria da região de interesse) em um número de 

regiões menores chamadas volumes de controle ou células. O conjunto dessas células é 

chamado de malha. Além disso, os valores escalares a serem calculados ficam armazenados no 
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centro dos volumes de controle. O software ainda utiliza a técnica dos volumes finitos para 

converter a equação geral do transporte em um sistema de equações algébricas e usa diferentes 

métodos iterativos para resolve-las.  

 O processo se dá na seguinte ordem: 

• Divisão da geometria em regiões menores (volumes de controle) utilizando uma malha 

computacional. 

• Integração das equações governantes do fluido sobre todos os volumes de controle no 

domínio. 

• Conversão das equações resultantes da integral em um sistema de equações algébricas 

(discretização). 

• Busca pela solução do sistema de equações algébricas através de um método iterativo. 

A forma geral das equações do transporte, em sua forma conservativa, pode ser escrita 

como: 

 𝜕(𝜌𝜙)

𝜕𝑡
+ 𝑑𝑖𝑣(𝜌𝜙𝑢) = 𝑑𝑖𝑣(Γ 𝑔𝑟𝑎𝑑𝜙) + 𝑆𝜙, (3.5) 

onde a variável 𝜙 pode ser substituída por qualquer quantidade escalar, Γ é o coeficiente de 

difusão. O lado esquerdo da Equação (3.5) contém o termo da taxa de variação da quantidade 

escalar e também o termo convectivo. O termo difusivo e o termo fonte se encontram do lado 

direito da equação. Integrando ao longo de todo o volume de controle e aplicando o Teorema 

da Divergência de Gauss, nas equações gerais do transporte, tem-se: 

 𝜕

𝜕𝑡
∫ 𝜌𝜙𝑑𝑉 +

𝑉𝐶

∫ 𝑛(𝜌𝜙𝑢)𝑑𝐴
𝐴

= ∫ 𝑛(Γ grad 𝜙)𝑑𝐴 +
𝐴

∫ 𝑆𝜙𝑑𝑉.
𝑉𝐶

 (3.6) 

 

3.3 Método URANS – Unsteady Reynolds Averaged Navier Stokes Simulation 

 

   Na metodologia utilizada, é assumido que o escoamento é compressível e 

completamente turbulento. Consequentemente, os campos de velocidade e pressão são 

governados pelas equações de Navier-Stokes. Devido ao recurso computacional disponível, o 

fenômeno da turbulência foi considerado sem a resolução numérica de todas as escalas 

turbulentas. Portanto, a abordagem URANS foi utilizada.  
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 Logo, as equações governantes do escoamento são as de continuidade, momento e 

conservação da energia que podem sem descritas, respectivamente por: 

 𝜕𝜌

𝜕𝑡
+

𝜕𝑢𝑖

𝜕𝑥𝑖
= 0 (3.7) 

   

 𝜕𝜌𝑢𝑖

𝜕𝑡
+

𝜕𝜌𝑢𝑗𝑢𝑖

𝜕𝑥𝑗
= −

𝜕𝑝

𝜕𝑥𝑖
+

𝜕

𝜕𝑥𝑖
(2𝜇𝑆𝑖𝑗 − 𝜌𝑢𝑖𝑢𝑗) + 𝑝𝑓𝑖 (3.8) 

   

 𝜕

𝜕𝑡
[𝜌 (𝑒 +

1

2
𝑢𝑖𝑢𝑖)] +

𝜕

𝜕𝑥𝑗
[𝜌𝑢𝑗 (ℎ +

1

2
𝑢𝑖𝑢𝑖)] =

𝜕

𝜕𝑥𝑗
[𝑢𝑗(2𝜇𝑆𝑖𝑗 − 𝜌𝑢𝑖𝑢𝑗)] (3.9) 

   

onde 𝑢𝑖 e 𝑢𝑗  são as componentes da velocidade, 𝜌 é a densidade, p é a pressão mecânica, 𝜇 a 

viscosidade e 𝑓𝑖 a força por unidade de volume, como a força gravitacional, 𝑒 a energia interna 

específica e ℎ = 𝑒 + 𝑝 𝜌⁄  é a entalpia específica. 

 

3.4 Modelo de turbulência 𝒌 − 𝜺 

 

 O modelo de turbulência utilizado para resolver o problema abordado no trabalho foi o 

𝑘 − 𝜀. Ele consiste em um modelo de 2 equações que são acompanhadas por mais duas 

equações do transporte adicionais (uma para a energia cinética turbulenta 𝑘 e outra para a taxa 

de dissipação da turbulência 𝜀). Calcula-se também a viscosidade turbulenta 𝜇𝑡, que é avaliada 

em função de ambos 𝑘 e 𝜀. As equações do transporte para 𝑘 e 𝜀 nesse modelo são dadas por: 

𝜕

𝜕𝑡
(𝜌𝑘) +  

𝜕

𝜕𝑥𝑗
(𝜌𝑘𝑢𝑗) =

𝜕

𝜕𝑥𝑗
[(𝜇 +

𝜇𝑡

𝜎𝑘
)

𝜕𝑘

𝜕𝑥𝑗
] + 𝐺𝑘 + 𝐺𝑏 − 𝜌𝜀 − 𝑌𝑀 + 𝑆𝐾 (3.10) 

  

𝜕

𝜕𝑡
(𝜌𝜀) + 

𝜕

𝜕𝑥𝑗
(𝜌𝜀𝑢𝑗)

=
𝜕

𝜕𝑥𝑗
[(𝜇 +

𝜇𝑡

𝜎𝑘
)

𝜕𝜀

𝜕𝑥𝑗
] + 𝜌𝐶1𝑆𝑒 − 𝜌𝐶2

𝜀2

𝑘 + √𝜈𝜀
 + 𝐶1𝜀

𝜀

𝑘
𝐶3𝜀𝐺𝑏 + 𝑆𝜀 

(3.11) 

  

𝐶1 = 𝑚𝑎𝑥 [0,43 +
𝜂

𝜂 + 5
] (3.12) 
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𝜂 = 𝑆
𝑘

𝜀
 (3.13) 

  

𝑆 = √2𝑆𝑖𝑗𝑆𝑖𝑗 (3.14) 

Nas equações acima, 𝐺𝑘 indica a geração de energia cinética turbulenta devido aos 

gradientes de velocidade média, 𝐺𝑏 indica a geração de energia cinética turbulenta devido às 

flutuações, 𝑌𝑀 representa a contribuição da dilatação flutuante na turbulência compressível para 

a taxa de dissipação total. 𝐶1 e 𝐶2 são constantes, 𝜎𝑘 e 𝜎𝜀 representam o número de Prandtl 

turbulento para 𝑘 e 𝜀, respectivamente. 

 

3.5 Método de elementos finitos e modelo estrutural 

 

 Neste trabalho, foram realizadas análises estruturais transientes, bem como análises 

modais, de forma a avaliar a resposta dinâmica e características vibratórias da estrutura. Os 

equacionamentos apresentados a seguir são utilizados para resolver essa parte do problema 

fluido-estrutura.  

 A dinâmica estrutural é o estudo do comportamento das estruturas sujeitas à aplicação 

de cargas. Através de uma análise estrutural transiente, pode-se obter o histórico no tempo de 

respostas como deslocamentos, tensões e deformações. Considerando que o amortecimento 

estrutural não está envolvido no modelo de elementos finitos, a equação do movimento básica 

que governa esse tipo de sistema com múltiplos graus de liberdade é dada por  

 𝒎 𝒖̈ + 𝒌 𝒖 = 𝒑(𝑡) (3.15) 

onde 𝒎 é a matriz de massa estrutural, 𝒖̈ é o vetor de aceleração, 𝒌 é a matriz de rigidez 

estrutural, 𝒖 é o vetor de deslocamento e 𝒑 é o vetor de força, que é função do tempo. 

 A partir dessa equação, aplica-se o método de elementos finitos (FEM, em inglês). O 

princípio básico dessa técnica é encontrar uma solução aproximada para essa equação 

diferencial, por meio da divisão do volume da estrutura em elementos finitos menores. Dessa 

forma, o problema, que possuía infinitos graus de liberdade, passa a ter uma quantidade finita.  

 O processo se dá na seguinte ordem: 
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• Conversão da estrutura em um sistema de elementos finitos que são interconectados em 

seus nós e definição dos graus de liberdades desses nós.  

• Determinação das matrizes de massa e rigidez elementar, e do vetor de força elementar 

para cada elemento em um elemento na malha com referência ao grau de liberdade para 

o elemento. As relações de força-deslocamento e força de inércia – aceleração para cada 

elemento podem ser escritas como:  

 (𝒇𝑆)𝑒 = 𝒌𝑒 𝒖𝑒 (3.16) 

 (𝒇𝐼)𝑒 = 𝒎𝑒 𝒖̈𝑒 (3.17) 

onde 𝒌𝑒 é a matriz de rigidez elementar, 𝒎𝑒 é a matriz de massa elementar e 𝒖𝑒 e 𝒖̈𝑒 

são dos vetores de deslocamento e aceleração, para o elemento. 

• Formação da matriz de transformação 𝒂𝑒 (matriz booleana que contém zeros e uns) que 

conecta os valores de cada elemento à montagem de elementos globais. Ela 

simplesmente aloca os elementos das matrizes de massa, rigidez e deslocamento 

elementares nos lugares adequados das matrizes globais. Os deslocamentos elementares  

𝒖𝑒 podem ser relacionados à matriz global 𝒖 pela seguinte expressão: 

  𝒖𝑒 = 𝒂𝑒𝒖 (3.18) 

• Montagem das matrizes elementares para avaliar as matrizes e massa e rigidez global e 

o vetor de força aplicada para a montagem final: 

 𝒌 = 𝐴𝑒=1
𝑁  𝒌𝑒 (3.19) 

 𝒎 = 𝐴𝑒=1
𝑁  𝒎𝑒 (3.20) 

 𝒑(𝑡) = 𝐴𝑒=1
𝑁  𝒑𝑒(𝑡) (3.21) 

onde 𝐴 é um operador responsável pelo processo de montagem. De acordo com a matriz 

de transformação 𝒂𝑒, os elementos das matrizes de massa e rigidez elementares, bem 

como os do vetor de força elementar, estão alocados nas respectivas matrizes globais e 

esse arranjo é baseado no número de cada elemento 𝑒 = 1 até 𝑵𝑒 (número de 

elementos). 

• A equação final do movimento com as matrizes globais é formulada usando a equação 

básica que governa o sistema. Essa equação pode ser resolvida para 𝒖(𝑡) usando um 

esquema de iteração adequado que dê a resposta do sistema em termos dos 

deslocamentos nodais. 
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 Com base nessa sequência de passos, os valores das matrizes de massa e rigidez 

elementares e do vetor de força elementar são determinados por uma função chamada de função 

de forma ou função de interpolação.  

 

3.6. Análise Modal 

 

Geralmente, a análise modal é utilizada para determinar as características de vibração 

de uma estrutura. As características de vibração como frequência natural e modos de vibrar de 

uma estrutura são importantes no projeto de uma estrutura sujeita a cargas dinâmicas. Pode-se 

considerar como um ponto inicial, ou análise prévia, para a simulação em regime transiente. 

Além disso, a resposta da estrutura pode ser calculada quando os modos são excitados. A 

equação básica utilizada em uma análise modal não amortecida é o clássico problema de 

autovalor dado por 

 𝒌𝝓𝒊 = 𝜔𝑛
2 𝒎 𝝓𝒊 (3.22) 

Onde 𝜙𝑖 é o vetor de modos de vibrar (autovetor) do modo 𝑖 e 𝜔𝑛 é a frequência natural 

do modo i. Caso o escoamento induza cargas dinâmicas que excite a estrutura em uma 

frequência próxima a alguma frequência natural da mesma, é possível que o sistema entre em 

ressonância e colapse. Desse modo, torna-se essencial o processo de encontrar as frequências 

naturais e os principais modos de vibrar associados da estrutura.  

 

3.7. Acoplamento FSI 

 

O projeto de estruturas que sofrem cargas aerodinâmicas de algum escoamento incidente 

exige atenção específica nas análises estática e dinâmica e requer ferramentas de simulação 

mais precisas para melhorar o desempenho do sistema e também minimizar o custo de 

fabricação. O pacote comercial do ANSYS foi utilizado, sendo o CFX para simulação de fluidos 

computacional e o ANSYS Mechanical para a simulação estrutural. A abordagem tradicional 

de determinação de tensões e deformações de uma estrutura sob um escoamento incidente 

consiste de uma simulação de fluidodinâmica (CFD) que proverá o campo de pressão na 

estrutura. Esta condição, então, pode ser interpretada como uma condição inicial ou condição 

de contorno para a simulação em método de elementos finitos do sistema (Schmucker et al. 

2010). Tal abordagem é denominada acoplamento unidirecional, ou one-way coupling, visto 
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que as deformações da estrutura não são inseridas no programa de CFD de modo que uma 

solução mais precisa seja encontrada e o ciclo seja fechado. Para que esta última sistemática 

seja adotada, é necessário que a simulação do comportamento aeroelástico seja do tipo 

bidirecional, ou two-way. 

A solução de problemas FSI envolve simulações multi-campo de dois comportamentos 

físicos separados. Primeiramente, o fluido produz as cargas na estrutura sólida e, então, o sólido 

reage com tensões e deformações inseridas no escoamento. A deflexão resultante do sólido 

afeta o fluido de modo que o escoamento deva se adaptar à nova condição de contorno. Se 

considerado os efeitos transientes, o campo do fluido escoante age sobre a estrutura como uma 

força inicial e também como um amortecimento estrutural, o que requere mais energia. (Khalid 

et al. 2013; Schmucker et al. 2010). A solução de uma simulação multi-campo geralmente 

requer dois solvers separados, um para o fluido (CFD) e outro para a estrutura (FEM) que 

realizam as operações em ordem sequencial quando as informações são compartilhadas entre o 

CFX e o Mechanical nos pontos de sincronização. Um fluxograma para a simulação multi-

campo com o ANSYS e as sequencias de sincronização são apresentados na Figura 3.1. 

 

 

Figura 3.1. Esquema de atuação do FSI. 
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Enquanto o CFX fornece as forças, o Mechanical retorna as deflexões resultantes e as 

duas malhas são adaptadas à nova geometria. A simulação completa é realizada até que um 

critério de convergência seja satisfeito, por exemplo, caso as deflexões calculadas entre um 

passo temporal e outro apresentem valor menor que o pré-estabelecido. Detalhes podem ser 

obtidos na documentação oferecida pelo ANSYS. 

Como mencionado anteriormente, o pacote ANSYS suporta dois tipos de interação 

fluido-estrutura: one-way e two-way. Na simulação unidirecional, os resultados do CFD são 

aplicados como cargas, na análise estrutural de elementos finitos, porém os resultados desta não 

são transmitidos àquela. Na simulação bidirecional, os resultados de deslocamentos obtidos 

pelo software de elementos finitos são utilizados para alterar a geometria do problema e 

repassados para o software de CFD. Neste trabalho é utilizada somente a abordagem two-way, 

para garantir melhor representabilidade do fenômeno aeroelástico. 

 

3.8 FSI Bidirecional (two-way) 

 

Em uma modelagem bidirecional de um problema FSI, os resultados da análise de CFD 

são transferidos para o modelo mecânico. Os deslocamentos calculados subsequentemente na 

interface são transferidos de volta para a análise de CFD. A capacidade de acoplamento que é 

fornecida atualmente permite que o CFX trabalhe em conjunto com o ANSYS Mechanical 

dentro de uma simulação ANSYS Multi-campo.  

Durante as simulações acopladas, o ANSYS CFX e Mechanical executam a simulação 

através de uma sequência de passos de tempo multi-campo, em que cada passo temporal 

consiste de uma ou mais iterações de acoplamento. Simulações acopladas se iniciam com a 

execução do ANSYS Mechanical e do CFX. O solver Mechanical age como um processo 

acoplador principal, no qual o solver CFX se conecta.  

Uma vez que a conexão for estabelecida, os solvers avançam por uma sequência de seis 

pontos de sincronização pré-definidos. A cada um destes pontos de sincronização, cada solver 

coleta os dados necessários do outro solver com o propósito de avançar para o próximo ponto. 

As iterações são repetidas até que um número máximo de iterações seja atingido ou até que os 

dados transferidos entre os solvers e todas equações de campo tenham convergido. 

 

  

 



 

 

 

 

 

 

 

 

 

CAPÍTULO IV 

 

AGARD 445.6 

 

 

“From error to error one discovers the 

entire truth.” – Sigmund Freud 

 

 O Advisory Group for Aerospace Research and Development (AGARD) foi uma 

agência da Organização do Tratado do Atlântico Norte (OTAN) que existiu entre 1952 e 1996. 

Muitas pesquisas foram realizadas pelo grupo, dentre elas, o comportamento aeroelástico da 

asa AGARD 445.6 que será estudada neste capítulo. 

 

4.1 Geometria 

 

A AGARD 445.6 é uma asa testada por Yates Jr. (1987) no NASA Langley Research 

Center. O primeiro dígito do nome da asa indica sua razão de alongamento de 4. Os dois 

próximos dígitos se referem ao enflechamento de 45°, localizado em um quarto da corda. O 

último dígito indica a razão de afilamento da asa (0,66). O perfil utilizado em sua construção é 
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o NACA65A004 e não apresenta torção geométrica e nem diedro ao longo da sua semi-

envergadura. 

A corda da raiz do modelo tem 0,55 m e sua semi-envergadura apresenta 0,76 m. A 

semi-envergadura do modelo foi afixada diretamente na parede do túnel de vento, e, portanto, 

a raiz da asa se encontra dentro da camada limite do escoamento. 

 

 

Figura 4.1. Vista 2D da AGARD 445.6. 

  

4.2 Material e propriedades 

 

A AGARD 445.6 é fabricada em mogno laminado, com propriedades estruturais 

diferentes em cada direção. Além disso, o modelo utilizado nos experimentos teve sua 

superfície perfurada afim de alterar sua rigidez para obter as condições de flutter mais 

facilmente. As propriedades do material são apresentadas na Tabela 4.1, onde 𝐸 é o módulo de 

elasticidade, 𝐺 é o módulo de cisalhamento e 𝜌 é a densidade do material. 

A direção do módulo de elasticidade principal 𝐸11 é a direção da envergadura, ou seja, 

45° em relação à corda na raiz do modelo, como é apresentado na Figura 4.2. 
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Figura 4.2. Eixo com direção x ao longo da envergadura. 

 

Tabela 4.1 Propriedades do Mogno Laminado utilizado na AGARD 445.6 (Yates Jr 1987). 

Propriedade do Material Valor 

𝐸11 3,1511 GPa 

𝐸22 0,41621 GPa 

𝐸33 0,41621 GPa 

𝜈12 0,31 

𝜈13 0,31 

𝜈23 0,31 

𝐺12 0,4392 GPa 

𝐺23 0,4392 GPa 

𝐺13 0,4392 GPa 

𝜌 397 𝑘𝑔/𝑚3 

 

As frequências dos quatro primeiros modos de vibrar da estrutura foram simulados e 

são apresentados na seção a seguir, que também confronta os valores de frequência obtidos por 

Yates Jr para o modelo afim de garantir similaridade estrutural. 

 

4.3 Validação modal AGARD 445.6 

 

O objetivo da análise modal é determinar os modos de vibrar da estrutura e as 

frequências naturais da asa AGARD 455.6 durante uma vibração livre. As frequências naturais 

da asa são dependentes somente da massa e da rigidez da estrutura e independem das forças 
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aplicadas. A interpretação física dos autovalores e autovetores é de que os autovalores 

representam as frequências associadas a cada um dos autovetores. Nos problemas mais práticos 

e comuns de engenharia, os modos desejados são os de menores frequência, pois correspondem 

aos modos principais de vibração da estrutura, dominando os modos de maiores frequências. É 

importante também conhecer os modos de vibrar da estrutura para garantir que uma carga 

oscilatória não coincida com alguma frequência modal e cause ressonância, que levará a 

maiores amplitudes de oscilação. 

A análise modal foi conduzida no ANSYS Mechanical, que utiliza seu solver modal ou 

SAMCEF, dependendo do sistema selecionado. A geometria do modelo foi importada do 

CATIA, um software de CAD que foi utilizado para a criação da superfície do aerofólio. A 

malha estrutural criada apresentou 4740 elementos. A condição inicial para a análise espectral 

foi de uma força vertical de 10 Newtons para baixo, atuante no bordo de fuga da ponta da asa, 

excitando os principais modos de torção e flexão da estrutura. A resposta não amortecida da 

estrutura no domínio da frequência é apresentada no espectro da Figura 4.3. 

 

 

Figura 4.3. Função de resposta em frequência da estrutura. 

 

Numa análise modal do pacote ANSYS (e outras análises baseadas em autovalores 

como flambagem), a solução consiste da geometria deformada normalizada por um fator 
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arbitrário. O valor real das magnitudes e suas derivadas, tais como deformações e tensões, são 

sem sentido. Apenas os valores relativos das magnitudes devem ser considerados. O valor 

normalizante arbitrário é numericamente sensível a pequenas perturbações na análise. Utilizar 

um sistema unitário diferente, por exemplo, pode gerar um novo fator de normalização. 

  A Tabela 4.2 apresenta os resultados de frequência natural associados aos quatro 

principais modos de vibração da estrutura resultantes da modelagem de elementos finitos 

estrutural e compara com os resultados obtidos na literatura. O primeiro e o terceiro modos são 

de flexão, o segundo e quarto são de flexão. Pode-se observar que os valores estão em 

concordância com os valores obtidos na literatura e experimentos anteriores. Os modos de 

vibrar são ilustrados na Figura 4.5, em conjunto com os resultados experimentais de Yates Jr 

(1987). Nota-se que existe concordância entre os contornos e, portanto, a estrutura simulada 

tem comportamento dinâmico semelhante à da ensaiada no NASA Langley Research Center. 

Tabela 4.2 Comparação de frequências 

 Trabalho atual  Ayakaban (2008) Zuijlen (2007) Yates Jr (1987) 

1º modo [Hz] 9,64 9,60 9,59 9,60 

2º modo [Hz] 39,01 40,47 40,23 38,10 

3º modo [Hz] 52,17 50,92 50,69 50,70 

 4º modo [Hz] 93,32 98,11 97,52 98,50 

 

 

Figura 4.4. Frequências naturais destacadas. 
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Figura 4.5. Comparação dos modos experimentais. 
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4.4 Análise FSI – módulo estrutural 

 

 Para definir a análise estrutural no ANSYS, é necessário suprimir a região de fluido 

(domínio) da geometria utilizada. Dessa forma, tem-se neste módulo, apenas a geometria da 

AGARD 445.6. O domínio será apresentado na seção seguinte.  

 É necessária a criação de um sistema de coordenadas em que a direção x acompanhe a 

envergadura, para garantir que o material seja aplicado de forma adequada na estrutura e que 

esta responda às solicitações mecânicas nas direções corretas.  

 Em seguida, foi elaborada a malha estrutural com elementos de 0,01 m de tamanho 

mínimo. Foi aplicado o método Sweep com elementos quadrados e triangulares. Ao fim do 

processo, a malha obtida é constituída por 5464 nós e 780 elementos. Foram testadas várias 

configurações antes desta, mas por questão de custo computacional, ela foi adotada. 

 

 

Figura 4.6. Malha estrutural. 

 

 Com a malha definida, foram estabelecidos os parâmetros temporais da análise 

estrutural, já que se trata de um estudo transiente. O tempo escolhido para análise foi de 3 s, de 

maneira a procurar compreender vários ciclos do fenômeno físico sem comprometer muito o 

tempo de processamento da simulação.  
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 Já o passo de tempo definido foi de 0,0025 s. O motivo da escolha é que, de acordo com 

o teorema da amostragem de Nyquist-Shannon, esse passo temporal permite que se observe 

frequências de até 200 Hz, ao se aplicar a Transformada de Fourier, para a futura análise no 

domínio da frequência. Ou seja, essa faixa cobre as primeiras 4 frequências naturais, que é a 

região de interesse do problema. 

 A condição de contorno aplicada foi um engaste na raiz da asa. A condição inicial foi 

uma força aplicada no bordo de fuga da ponta da asa com uma duração de 0,1 s. Essa força é 

de 10 N, orientada na direção y para baixo. 

 

 

Figura 4.7. Força aplicada. 

 

 Por fim, foi aplicada uma condição em toda as superfícies da asa (com exceção daquela 

que está engastada) para que o software as identifique como região de interface entre o fluido 

e a estrutura. Ou seja, os deslocamentos enviados para o CFX são os dos elementos dessa região.  

 

4.5 Análise FSI – módulo fluidodinâmico 

 

A simulação fluidodinâmica foi conduzida no ANSYS CFX, que é um solver baseado 

em método de volumes finitos com um solver multigrid acoplado paralelamente com um 

esquema advectivo de segunda ordem. Além disso, os termos transientes nas equações 

governantes são resolvidos utilizando um algoritmo implícito retroativo de segunda ordem. O 

domínio computacional possui dimensões 8 m x 2,5 m x 2,5 m e formato apresentados na Figura 

4.8. Considerou-se que o domínio possui dimensões suficientes para a representação física do 
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experimento. A malha gerada para este domínio apresentou 2.117.911 elementos. As condições 

de contorno a seguir foram aplicadas neste domínio afim de replicar numericamente o 

experimento: 

 

 

Figura 4.8. Domínio fluidodinâmico. 

 

 

Figura 4.9. Detalhe da malha do domínio. 

 

Tipo de análise: análise transiente com acoplamento externo do tipo ANSYS Multifield, 

de duração de 3 s e passos temporais de 0,0025 s, em concordância com as configurações da 

análise transiente do solver estrutural. 
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Controle do solver: esquema advectivo de alta resolução. Número máximo de 100 

iterações. Critério de convergência baseado no resíduo RMS, satisfazendo os critérios quando 

menor que 1e-4. 

Fluido: substância pura, ar seco a 25 °C e 1 atm, apresentando densidade de 1,185 kg/m³ 

e incompressível. 

Domínio: comportamento térmico adiabático, com modelo de turbulência 𝑘 − 𝜀 

escalável. As superfícies fronteiriças do domínio são definidas a seguir: 

Velocidade de entrada (INLET - A): a condição de Dirichlet aplicada define que uma 

velocidade uniforme segue a direção normal à superfície de entrada do domínio, com 

turbulência de intensidade 5%. A pressão é calculada afim de satisfazer as equações de 

transporte. 

Superfície FSI (INTERFACE - B): a condição de não-deslizamento foi aplicada nas 

superfícies da asa, implicando que a velocidade do fluido em relação à malha deformante é 

nula. As superfícies foram definidas como interfaces de interação fluido-estrutura, de modo que 

solver estrutural recebesse os dados acerca das forças aerodinâmicas provocadas pelo 

escoamento do fluido. 

Pressão de saída (OUTLET - C): a condição de Dirichlet aplicada nesta face é tal que 

define a pressão de saída relativa de 0 Pa. Deste modo, o campo de velocidade é calculado afim 

de satisfazer as equações de transporte. 

Simetria (SYMMETRY - D): aplicado na superfície lateral, referente ao engaste da asa. 

Nesta condição, a velocidade na superfície é nula. 

Para cada caso, foi variada a velocidade de entrada, bem como a componente u do fluido 

no domínio. As simulações foram conduzidas para cada valor de velocidade do fluido. Os 

pontos da estrutura monitorados são os bordos de ataque e fuga da corda da ponta da asa. O 

deslocamento vertical desses pontos foi registrado para cada passo temporal. 

 

4.6. Análise dos resultados 

 

 Utilizando todas as configurações citadas anteriormente, realizaram-se as simulações 

FSI, alterando-se apenas a velocidade do escoamento que incide sobre a AGARD 445.6. 
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 O primeiro valor simulado foi de 50 m/s. A Figura 4.10 apresenta a evolução temporal 

do deslocamento vertical dos bordos de ataque e fuga da ponta da asa. É observado o 

comportamento dinâmico convergente, com decaimento ao longo do tempo. Os altos valores 

de deslocamentos observados até 0,1 s são consequência da aplicação da força no bordo de 

fuga, que atuou como condição inicial para a excitação dinâmica da estrutura nos dois modos 

de vibrar mais importantes. 

 A resposta em frequência da excitação oscilatória é apresentada na Figura 4.11. São 

observados dois picos em amplitude, próximos às duas frequências naturais associadas aos dois 

primeiros modos (primeiro modo de flexão e primeiro modo de torção).  

 Dadas as evidências supracitadas, é possível concluir que essa velocidade (50 m/s) não 

excita a estrutura de modo que ocorra a oscilação auto excitada. 

 

 

Figura 4.10. Deslocamento dos bordos de ataque e fuga para 50 m/s. 
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Figura 4.11. Função de resposta em frequência para 50 m/s. 

 

A segunda velocidade do escoamento avaliada foi de 75 m/s. O comportamento 

dinâmico da estrutura se assemelhou ao caso anterior. É possível observar na função resposta 

em frequência que os picos em amplitude referentes aos dois primeiros modos apresentam 

deslocamento horizontal do pico no domínio da frequência, indicando leves indícios do início 

da coalescência dos modos. 

 

 

Figura 4.12. Deslocamento dos bordos de ataque e fuga para 75 m/s. 
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Figura 4.13. Função de resposta em frequência para 75 m/s. 

 

 A análise com velocidade de 95 m/s mostrou que as frequências continuavam a se 

aproximar, porém o deslocamento no tempo segue convergente para 0 m.  

 

 

Figura 4.14. Deslocamento dos bordos de ataque e fuga para 95 m/s. 
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Figura 4.15. Função de resposta em frequência para 95 m/s. 

 

 Na simulação considerando 100 m/s, as oscilações temporais cessaram, após a aplicação 

da condição inicial. Os picos na FRF já se encontram mais próximos, o que indica que o flutter 

é iminente.  

 

 

Figura 4.16. Deslocamento dos bordos de ataque e fuga para 100 m/s. 
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Figura 4.17. Função de resposta em frequência para 100 m/s. 

 

Para a análise de 105 m/s, o deslocamento não cessa até o final do tempo simulado. No 

entanto, as oscilações ocorrem com amplitude pequena. Já o domínio da frequência revela que 

os picos estão prestes a se encontrar. 

 

 

Figura 4.18. Deslocamento dos bordos de ataque e fuga para 105 m/s. 
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Figura 4.19. Função de resposta em frequência para 105 m/s. 

  

Adotando a velocidade de 110 m/s, obteve-se que o deslocamento deixa de ser 

convergente e as oscilações passam a acontecer em amplitudes maiores, porém praticamente 

constante. Com a função de resposta em frequência, nota-se que os picos se juntaram na 

frequência de 25,52 Hz. 

 

 

Figura 4.20. Deslocamento dos bordos de ataque e fuga para 110 m/s. 
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Figura 4.21. Função de resposta em frequência para 110 m/s. 

 

 Já a análise de 120 m/s não pôde ser concluída, pois a amplitude do deslocamento 

chegou à valores extremamente altos, e que aumentavam cada vez mais. O software só foi capaz 

de calcular o acoplamento entre o fluido e a estrutura até pouco antes de 0,45 s. 

 

 

Figura 4.22. Deslocamento dos bordos de ataque e fuga para 120 m/s. 
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Ao se criar a animação a partir do deslocamento de todos os nós da estrutura, percebe-

se claramente que a estrutura vibra de maneira que caracteriza o flutter, com o acoplamento dos 

modos de flexão e torção.  

É importante salientar, que para gerar todas as FRF’s apresentadas para a AGARD 

445.6, foi ignorada toda a faixa de tempo em que a força (condição inicial) estava sendo 

aplicada. Isso garante que as frequências provenientes da excitação realizada não apareçam no 

espectro. Ou seja, ele é composto apenas pela resposta da estrutura.  

Após análise das respostas transientes e espectrais do sistema aeroelástico, é possível 

estimar que a velocidade crítica de ocorrência do fenômeno de flutter aeroelástico é de 110 m/s. 

Esse valor de velocidade equivale à uma pressão dinâmica de 𝑞 = 7169,25 Pa, visto que a 

condição de atmosfera simulada foi o ar ambiente, a 25° C e  𝜌 = 1.185 kg/m³.  

Na velocidade crítica, observa-se que o escoamento excita o sistema aeroelástico com 

mais energia do que é absorvida pela estrutura, induzindo a coalescência dos dois primeiros 

modos em torno de 25 Hz, ou na frequência adimensional de flutter  
𝜔

𝜔𝛼
 de 0.641, evidenciando 

concordância com os experimentos de Yates (1978) na região de números de Mach até 0.3 e 

resultados de outros softwares específicos para cálculos de aeroelasticidade, como o 

NASTRAN. 

Os comportamentos dinâmicos da estrutura em velocidades acima de 120 m/s nestas 

condições atmosféricas não foram simulados por limitações do software. A própria turbulência 

do fluido é capaz de excitar a estrutura como condição inicial e os fenômenos aeroelásticos 

provocam deflexões maiores que o limite de cálculo do solver estrutural. 

Para a análise clássica de aeroelasticidade, foi construído o diagrama V-f e V-g, com 

fins de visualização da coalescência das frequências e verificação da evolução do 

amortecimento do sistema.  

O cálculo do amortecimento se deu utilizando o método da meia banda de potência. Esse 

método pode ser utilizado para estimar o fator de amortecimento de estruturas com múltiplos 

graus de liberdade a partir da variação em -3 dB em amplitude da resposta em frequência. 
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Figura 4.23. Diagrama V-g-f. 

 

A Figura 4.24 apresenta, em perspectiva, as funções de resposta em frequência do 

sistema aeroelástico, na banda de 0 a 50 Hz. É possível observar, que em velocidades menores, 

o sistema apresenta dois picos em sua FRF, localizados na região de 10 Hz e 40 Hz. Esses picos 

são referentes às frequências naturais da estrutura.  

Com o aumento da velocidade, nota-se que a primeira frequência natural sofre um 

deslocamento no espectro para a direita, ou seja, o valor da primeira frequência natural tende a 

aumentar. Percebe-se também, que a segunda frequência natural sofre um deslocamento para a 

esquerda, ou seja, o valor da segunda frequência natural tende a diminuir. Esse processo 

continua até que seja atingida a velocidade de flutter. 

As funções de resposta em frequência das velocidades superiores a 110 m/s apresentam 

apenas um pico, em torno de 26 Hz. Esse fenômeno evidencia a coalescência dos modos na 

condição de flutter aeroelástico. A partir deste momento, a estrutura passa a oscilar com seus 2 

modos de vibrar principais na mesma frequência. 
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Figura 4.24. FRF’s para todas as velocidades. 

 

A Figura 4.25 mostra os contornos do campo de pressão do escoamento ao redor da asa 

nos passos temporais em que a estrutura alcança o máximo ângulo de ataque devido à torção da 

estrutura. Nota-se que o ponto de estagnação é localizado na porção inferior do bordo de ataque 

com maiores valores de pressão. 

 

 

Figura 4.25. Contorno de pressão (máximo deslocamento). 
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A Figura 4.26 apresenta os contornos do campo de pressão do escoamento para a 

condição de equilíbrio da asa. É notável que a distribuição do gradiente do campo de pressão 

do escoamento se mantém simétrico em relação à corda da asa. 

 

 

Figura 4.26. Contorno de pressão (médio deslocamento). 

 

A Figura 4.27 apresenta os contornos do campo de pressão do escoamento nos passos 

temporais em que a estrutura alcança o mínimo ângulo de ataque devido à torção da estrutura. 

Nota-se que o ponto de estagnação é localizado na porção superior do bordo de ataque com 

maiores valores de pressão. 

 

 

Figura 4.27. Contorno de pressão (mínimo deslocamento). 
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É possível concluir que a coordenada generalizada que apresenta maior variação durante 

a condição de flutter é a torção, alterando significativamente o ângulo de ataque da estrutura. 

Em consequência, o campo de pressão se reorganiza e promove variação na força de sustentação 

gerada, que por sua vez, infere deslocamentos translacionais na vertical. 



 

 

 

 

 

 

 

 

 

CAPÍTULO V 

 

CONCLUSÕES E PERSPECTIVAS 

 

 

“Those who dare to fail miserably can 

achieve greatly.” – John F. Kennedy 

 

Com base em todas as análises realizadas no decorrer deste trabalho, este capítulo 

apresenta as conclusões que puderam ser feitas e ideias para trabalhos futuros. 

Primeiramente, pode-se validar a metodologia utilizada para a identificação do 

fenômeno de flutter. O FSI 2 way se mostrou capaz de fornecer informações relevantes e 

coerentes com a literatura. Dentro do ambiente acadêmico em que estamos inseridos, é muito 

mais comum a utilização do NASTRAN para resolver esse tipo de questão. Porém, foi muito 

válida a aquisição de conhecimentos utilizando uma abordagem diferente. 

Considerando o primeiro caso, AGARD 445.6, as análises realizadas apresentaram 

resultados bastantes satisfatórios, mesmo com as limitações impostas por se utilizar um 

computador simples. Além disso, por se tratar de uma geometria bastante estudada, foi de certa 

forma fácil encontrar resultados para comparação, tanto numéricos como experimentais.  
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A coalescência das frequências pôde ser facilmente observada por meio das funções de 

resposta em frequência calculadas. O software também foi capaz de evidenciar a instabilidade 

gerada pelo fenômeno aeroelástico (deslocamento temporal referente às simulações com 

velocidade do escoamento de 105 e 110 m/s). Portanto, o comportamento da frequência pôde 

ser facilmente mapeado em função da velocidade (diagrama V-f). 

Como o software fornece apenas dados de deslocamento em função do tempo, torna-se 

um pouco mais complicado o cálculo dos fatores de amortecimento modal para cada análise. 

No entanto, esses parâmetros puderam ser estimados por meio do método da meia banda de 

potência. O fator de amortecimento, para os dois modos de interesse, foi mapeado em função 

da velocidade (diagrama V-g). A conclusão que se chegou é que em um dos modos, o fator de 

amortecimento passa a ser positivo. 

Portanto, no caso da AGARD 445.6, todas as principais características do flutter 

puderam ser observadas e o fenômeno finalmente constatado. Foram geradas também, várias 

animações, que mostram a movimentação de toda a estrutura sofrendo o flutter.  

Outra consideração pertinente é que a principal limitação do trabalho foi o elevado 

tempo necessário para realizar cada simulação transiente, devido ao grande número de passos 

temporais.  

As simulações referentes à AGARD 445.6 levaram em média 20 horas para serem 

concluídas. Elas foram realizadas com processamento paralelo de 8 núcleos em um computador 

Intel i7@3,40 Hz com 8GB de RAM. 

No entanto, é necessário manter o passo temporal em um valor baixo, para que a taxa 

de amostragem seja suficiente para realizar a análise espectral em um intervalo de frequência 

satisfatório, como é estabelecido pelo Teorema da Amostragem de Nyquist-Shannon.  

Para trabalhos futuros, seria interessante a utilização de modelo de fluido que permita 

ao solver aerodinâmico calcular velocidades além do regime subsônico. Isso pode ser obtido 

utilizando a consideração de gás ideal e definindo temperaturas e pressões específicas para que 

os números de Mach na faixa transônica sejam avaliados.  

Na faixa transônica (Mach 0,9 a 1,1), aparece o fenômeno do transonic deep, que 

caracteriza o comportamento não-linear da evolução da velocidade crítica de flutter.  
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Ou seja, avaliando-se uma faixa mais ampla de números de Mach, ou até mesmo, 

variando a altitude (pela variação das propriedades físicas do ar: temperatura, pressão e 

densidade), pode-se validar por completo a metodologia utilizada perante os experimentos de 

Yates Jr.  
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APÊNDICE  

A. Tutorial ANSYS 

 

1. Configuração do workbench 

Com o workbench aberto, selecione a toolbox Transient Structural. Com o botão direito em 

Setup, selecione a opção Transfer Data to New > Fluid Flow (CFX).  

Clique com o botão direito e delete a linha Solution do Transient Structural (A6). Dessa forma, 

o workbench fica como ilustrado abaixo.  

 

2. Transient Structural 

Feita a configuração do workbench, selecione o item Engineering Data (A2), defina o material 

a ser utilizado na estrutura. Primeiro é necessário adicionar o nome do material na região 

indicada. 

 

Em seguida, arraste as propriedades Density e Orthotropic Elasticity (ou Isotropic dependendo 

do material a ser utilizado) da coluna Toolbox até o material que acabou de ser criado. Preencha 

as propriedades em amarelo.  
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Clique com o botão direito no material criado e selecione a opção Default Solid Material For 

Model. Assim, o novo material será automaticamente aplicado na parte estrutural. 

 

2.1 Geometria 

É recomendado desenhar a geometria (asa + domínio) em algum software externo como o 

CATIA e salvar o desenho como “.stp”. Voltando no workbench, clique com o botão direito 

em Geometry na caixa Transient Structural e selecione Import Geometry > Browse from 

repository.  

 

Com a geometria importada, abra o Geometry (A3). Vá em Create > Boolean. Em Details 

View, selecione a Operation Subtract. O target body é o domínio e o tool body a asa (ou a 
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estrutura do problema, caso esteja resolvendo outra aplicação). Clique com o botão direito em 

Boolean1 e selecione Generate. Isso faz uma espécie de corte no domínio, exatamente na região 

ocupada pela estrutura. É imprescindível esse passo para definir posteriormente onde ocorre a 

interação fluido-estrutura. Salve o projeto e feche a seção Geometry.  

 

2.2 Model 

De volta ao workbench, abra o Model (A4). Em outline, abra Model (A4) > Geometry. Clique 

com o botão direito na parte do domínio e selecione Supress Body. Ele irá desaparecer e restará 

somente a asa (ou estrutura do problema).  

Ainda em Model (A4) > Geometry, certifique-se de que a estrutura esteja com o material que 

foi criado e que esse material segue o sistema de coordenadas adequado. 

IMPORTANTE: É necessário checar se de acordo com propriedades do material, é requerida 

a criação de um novo sistema de coordenadas. No caso da AGARD 445.6, uma das propriedades 

do mogno acompanha o eixo da envergadura. Porém a envergadura não acompanha o eixo x e 

foi necessário criar um eixo ao longo da envergadura.  
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Em Model (A4) > Mesh, é preciso configurar os parâmetros para a criação da malha. Isso vai 

de acordo com a geometria sendo trabalhada. 

Em Project > Model (A4) > Transient (A5) > Analysis Settings, selecione: 

Auto Time Stepping: Off 

Define By: Time 

Step End Time: (Tempo em segundos de simulação)  

Time Step: (Passo de tempo a ser empregado) 

 

Em seguida, selecione o comando Face  . Selecione as superfícies em que serão aplicadas 

as condições de contorno. No caso da AGARD, é engastada a raiz da asa. Com essa superfície 

selecionada, clica-se com o botão direito e seleciona Insert > Fixed Support. 

Selecione também as faces em que ocorre a interação fluido estrutura. E aplique os comandos 

Insert > Fluid Solid Interface  

 

A aplicação de condições iniciais como força ou pressão fica a critério do usuário.  
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Salve o projeto e feche o módulo Model (A4). Certifique-se de que toda a caixa do Transient 

Structural esteja preenchida. Caso contrário, clique com o direito e selecione update nos 

módulos que não estiverem.  

 

 

2.3 Fluid Flow (CFX) 

De volta ao workbench, abra na caixa do Fluid Flow (CFX), o item Mesh (B3). 

Em Model (B3) > Geometry, selecione a parte sólida e clique com o direito para selecionar 

Supress Body. Dessa forma, sobra apenas a região fluida (com o recorte feito anteriormente).  

Em Model (B3) > Mesh, crie a malha para o fluido. Esse passo é altamente dependente da 

geometria a ser analisada.   

Com a ferramenta Face , selecione as geometrias para definir as regiões de Inlet, Outlet e 

Interface. 

INLET: Selecione a superfície, clique com o botão direito e selecione a opção Create Named 

Selection e dê o nome de INLET, clique em OK.  

OUTLET: Selecione a superfície, clique com o botão direito e selecione a opção Create Named 

Selection e dê o nome de OUTLET, clique em OK.  

INTERFACE: Selecione as superfícies (a parte recortada do domínio que é ocupada pela asa, 

menos o engaste), clique com o botão direito e selecione a opção Create Named Selection e dê 

o nome de INTERFACE, clique em OK.  
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Salve e volte para o workbench.  

Abra o item Setup (B4). 

Em Outline > Simulation > Flow Analysis 1 > Analysis Type, preencha o tempo de acordo com 

o que foi estabelecido no módulo estrutural. 
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Em Outline > Simulation > Flow Analysis 1 > Analysis Type > Default Domain são definidas 

as configurações referentes ao fluido de trabalho.  
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Para cada região (INLET, OUTLET e INTERFACE), repita os procedimentos a seguir: 

Em Outline > Simulation > Flow Analysis 1 > Default Domain, clique com o botão direito e 

selecione Insert > Boundary. Nomeie cada uma com o mesmo nome da região em questão.  

 

Configurações do INLET 

 

 

 

Na região destacada, insere-se as componentes de velocidade do escoamento em x, y e z. 
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Configurações do OUTLET 

 

 

 

 

Configurações do INTERFACE 
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Aplique as configurações e selecione OK. 

Selecione Global Initialization  para definir os valores iniciais (da primeira iteração). Na 

região destacada, devem ser colocados os mesmos parâmetros do INLET. 
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Aplique as configurações e selecione OK. 

Em Solver Control , são definidos os resíduos, ou seja, os controles e critérios de 

convergência.  
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Aplique as configurações e selecione OK. 

Em output control  são definidos os pontos e variáveis que serão monitorados ao longo da 

simulação. 
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No caso da AGARD, foram estabelecidas as coordenadas do bordo de ataque e fuga da ponta 

da asa. Esses parâmetros ficam a critério do usuário, que define qual é a região de interesse para 

monitorar o deslocamento. Foi definido Total Mesh Displacement Y, pois desejava-se o 

deslocamento vertical.  

Espera-se que todas as mensagens de alerta do CFX tenham desaparecido.  

Salve o projeto e feche a janela, voltando para o workbench.  

Abra o Módulo Solution (B5). Na janela Define Run que irá abrir: 

Na aba Run Definition, selecione o Run Mode de acordo com seu computador (processamento 

serial ou Intel MPI Local Parallel com o número de processadores disponíveis em seu 

computador) 

Na aba Initial Values, selecione a Initialization Option de Initial Conditions. 

Clique em Start Run. 
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O gráfico de deslocamento será gerado. Para exportá-lo basta clicar com o direito e selecionar 

Export Plot Data. Dessa forma, pode-se levar os resultados para o MATLAB e começar as 

análises aeroelásticas. 

 

 

 


